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Workshop Overview 

Introducing Learn Adobe Photoshop with Surface Pro 4 and Surface 
Pen 
Learn Adobe Photoshop with Surface Pro 4 and Pen is a free 90-minute workshop held in Microsoft 
retail stores. Participants will gain an introductory knowledge of Adobe Photoshop, the world’s most 
popular graphics and photo editing software. Participants will learn how to use Adobe Photoshop 
Creative Cloud (CC) with a Surface Pro 4 and Surface Pen to correct imperfections in their photos, 
enhance images, and combine multiple photos into one. Participants will create original raster (pixel-
based) images and adjust existing images. Key concepts covered include: image creation, layers and 
layer styles, masks and filters, adjustments (color and size), tools (brushes and pens), automation and 
transparency overlay. Participants will have the opportunity to apply these concepts to drawings, images 
of people and backgrounds. 

How to Use This Guide  
This Leader Guide will be your reference as you prepare and deliver this workshop, and is designed to 
provide all the information you need to lead with confidence. To set you up for success, this document 
includes the following: 

• Workshop Overview: This introduction to the workshop’s content and target audience also 
includes key details about required preparation and set up. 

• Outline: As a summary of the main topics, this is a resource to stay on track when delivering the 
workshop. Time estimates are provided as a guide, although the actual amount of time required 
will vary depending on the knowledge level and learning style of the participants.  

• Presentation Guide: The main section of this document is a companion to this session’s 
PowerPoint slideshow, and offers suggested prompts and demonstrations to help you give a 
thorough, accurate and engaging presentation. 

Target Audience  
The target audience for this workshop is any individual with limited or introductory experience with 
Adobe Photoshop, Surface Pro 4, and/or Surface Pen who wants to gain knowledge and confidence with 
the basic fundamentals of the software program. No prior experience or knowledge is required. Each 
participant will be working with a Surface Pro 4, so the maximum attendance for the workshop should 
be in accordance with device availability.  
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Learning goals 

By the end of this workshop, participants will be able to: 

• Use the Surface Pro 4 and Surface Pen to create and edit images in Adobe Photoshop CC. 
• Apply basic and advanced features of Adobe Photoshop CC. 
• Take advantage of other workshops and educational experiences available at Microsoft Stores. 

How to Prepare for the Workshop 
Required preparation 

 Customize the final slide of the PowerPoint with the required information about your store: 
o Store URL 
o BSS name, email and photo 
o CDS name, email and photo 
o SM name, email and photo 

 Set up Surface Pro 4 devices for participants and ensure they are charged. 
 Check that Surface Pen batteries are charged and pair a Pen with each device. 
 Power the Surface Pro 4 devices on and open Adobe Photoshop Creative Cloud on each Surface 

Pro 4 to have them ready for the participants. 
 Download 4 Adobe Stock Photos on to each Surface Pro 4. 

Recommended preparation  

 Review all materials thoroughly and feel confident with the material. 
 Practice all demonstrations and activities in the Leader Guide.  
 Review Adobe TV and additional Adobe Photoshop Creative Cloud resources (listed in Participant 

Guide) to become proficient in Photoshop prior to workshop. 
 Practice your presentation in Slideshow mode to see on-click animations. 
 Be prepared to answer questions from participants.  

❗ NOTE: Workshop leaders can ask Adobe Photoshop experts on staff to help with preparation.  

Set Up and Materials  
Length 

One and a half hours (90 minutes) 

Staffing 

• One leader for 10 participants; workshops with more than 10 participants will require two staff.  
• If two staff members are needed, ideally, one staff member assumes the role of workshop leader 

and the other provides support to the participants. 
• Preparation support from the CDS may also be needed. 

Hardware & Devices 



Learn Adobe Photoshop with Surface Pro 4 and Pen – 90-Minute Workshop 

5 Microsoft confidential – for internal use only 2016 

• Surface Pro 4 and Surface Pen for leader.  
• Screen display for leader. 
• Surface Pro 4 for each participant, loaded with required applications and assets (see Required 

Preparation above and Software & Applications below).  
• Surface Pen for each participant.  

Software & Applications 

For all Surface Pro 4 devices: 

• Adobe Photoshop Creative Cloud (CC) 
• Office 2016 Home and Business: PowerPoint 
• Microsoft Edge (for accessing additional resources) 
• Windows 10 

Materials 

• Workshop Leader Guide 
• Workshop PowerPoint presentation 
• Printed Participant Guide for each participant 
• 4 Adobe Stock photos  

 

Resources for further learning about Photoshop 

• Adobe Photoshop CC: www.adobe.com/products/photoshop.html 
• Adobe Photoshop CC, Learn & Support: https://helpx.adobe.com/photoshop.html  
• Adobe® TV: tv.adobe.com  

www.adobe.com/products/photoshop.html
https://helpx.adobe.com/photoshop.html
http://tv.adobe.com/
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Outline 

You may use the outline below as a checklist when conducting the workshop. Suggested times for each 
section are noted for guidance. 

Section One: Introduction and Overview (10 minutes) 

• Welcome and Overview (2 min) 
• Introduction to Adobe Photoshop CC, Surface Pro 4 and Surface Pen (4 min) 
• Adobe Photoshop CC Video and User Interface (4 min) 

Section Two: Edit and Remove Imperfections (20 minutes) 

• Brush (5 min) 
• Spot Healing Brush (5 min)  
• Paint Bucket Tool (5 min) 
• Save Your Image (5 min) 

Section Three: Enhance Your Images (30 minutes)  

• Filters (5 min) 
• Create a Layer (8 min) 
• Layer Styles (5 min) 
• Eraser tools (7 min) 
• Magic Wand Tool (5 min) 

Section Four: Combine Multiple Photos (25 minutes) 

• Layer Masks (15 min) 
• Create Your Own (10 min) 

Section Five: Wrap Up (5 minutes) 

• Wrap Up and Thank You (5 min)  
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Presentation Guide 

Section One: Introduction and Overview (10 minutes) 

WELCOME AND OVERVIEW (2 MIN) 

 SHOW: Slide 1: Welcome 

 

 GOAL: Welcome participants to the workshop.  

 SAY: Hi everyone, welcome to the workshop where you’ll learn to learn how to use Adobe 
Photoshop Creative Cloud on Surface Pro 4 with Surface Pen. The tools and the tricks that you will 
learn in this workshop will also help you use Surface Pen to create images in more ways than might 
be available on a desktop or other device.  

 SAY: My name is _____________ and I’m your host for this workshop. I’ll be taking you through a 
combination of demonstrations and hands-on experiences where you’ll learn how to use Photoshop 
to create new images. 

 DO: Take role and collect email addresses of all registered participants. 

 SHOW: Slide 2: Overview 

 

 GOAL: Review the outline for the workshop.  

 SAY: Let’s talk about what we’ll be doing in this workshop.  

 First, we will go over some of the basic features of Adobe Photoshop CC and get introduced to 
Surface Pro 4 and Surface Pen. 

 Then, we will practice tools in Photoshop to make some simple edits and remove imperfections in 
your photos.  
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 After that, we will explore features that enable you to enhance your images, like selecting certain 
parts of an image and adjusting its color. 

 Finally, we will practice combining two different photos into one single image. 
 After all that, we will wrap up with information about additional resources. There will also be time 

for any questions you might have. 

 ASK: Are there any questions about today’s workshop before we move on?  

INTRODUCTION TO ADOBE PHOTOSHOP CC, SURFACE PRO 4 AND SURFACE PEN (4 MIN) 

 SHOW: Slide 3: Let’s get started 

 

 GOAL: Introduce the software and hardware for the workshop.  

 SAY: You’ve likely already heard of Photoshop, or at the very least you have probably heard 
someone refer to editing a picture as “Photoshopping” it. Today you are going to have a chance to 
do just that, Photoshop some images! 

 SAY: The latest version of Adobe Photoshop is Photoshop CC, which can be used on a desktop, 
tablet and other supported mobile devices. The great thing about Photoshop CC is that you can 
download it from the Adobe Creative Cloud to any device you might be using. You can only use your 
copy on one device at a time, but you can use it on almost any device anywhere you might be.  

 SAY: One important point when using Photoshop CC: it is a fairly large, sophisticated program, so 
it’s best to close other applications you are not using when you are working in it. 

 SHOW: Slide 4: Why Surface Pen? 

 

 GOAL: Describe the benefits of using Surface Pen with Photoshop. 
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 SAY: You might be wondering why you should use your Surface Pro 4 to edit with Photoshop versus 
your desktop. Surface Pro 4 allows your workflow to be more intuitive. When you want to draw, 
sketch and edit directly on your images, Surface Pro 4 with Surface Pen enables you to do just that!  

 SAY: Surface Pen isn’t simply a stylus that helps you highlight and add text, it also has several special 
features that give you the capability and feel of drawing with a pencil or pen. 

 SAY: Let’s go over some of the key features of Surface Pen: 

 Pressure sensitivity—up to 1024 levels with Surface Pro 4—means you can write and draw 
naturally to vary the thickness and lines. 

 Palm Block technology means that the Surface Pro 4 can automatically sense when your palm is 
resting on the device as you are using Surface Pen. This means no options will be accidentally 
selected or opened as you write or draw. 

 One-Click brings up OneNote. So if you regularly use OneNote to jot down notes as you work, it 
is easily opened with a single click. 

 An eraser is built in to Surface Pen. All you need to do is turn Surface Pen upside down and your 
tip is now an eraser, just like a regular pencil. 

ADOBE PHOTOSHOP CC VIDEO AND USER INTERFACE (4 MIN) 

  SHOW: Slide 5: Terry White Video 

 

 GOAL: Play the instructional video of Adobe Photoshop CC on Surface Pro 4.  

 SAY: Before we jump into our first activity, we are going to watch a short instructional video that will 
help get you acclimated to some of the features and capabilities of Photoshop. The video itself is just 
under four minutes and features Terry White, a Principal Worldwide Design and Photography 
Evangelist for Adobe. 

 DO: Play video (3:43). 
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 SHOW: Slide 6: User interface for Photoshop CC 

 

 GOAL: Review key features of the Photoshop CC user interface.  

 SAY: Let’s go over the main parts of the user interface. As I said before, Photoshop is a very 
sophisticated piece of software, and you will discover far more features and options than we could 
possibly cover in this 90-minute. But while I won’t get to every incredible tool and feature, I do want 
to get us acclimated to the user interface before we get started on any activities. When I start any 
hands-on activity I will refer to one of three parts of the interface: either the left sidebar, top menu or 
right sidebar.  

 SAY: I’ll now point out each of the three sections:  

 The left sidebar has tools such as Brush, Spot Healing, Eraser, Magic Wand, Paint Bucket, and 
Foreground/Background Color. 

 The top menu includes tools we will access today, such as File, Edit, Layer, and Select. 
 The right sidebar allows you to show or hide options like layers, which we will go over in more 

detail later. 

 ASK: Are you ready to get started? 

❗ NOTE: For additional help prior to presenting the workshop, watch the Photoshop workspace video 
at https://helpx.adobe.com/photoshop/how-to/introduction-work-area.html?set=photoshop--
fundamentals--photoshop-workspace. 

Section Two: Edit and Remove Imperfections (20 minutes) 

BRUSH TOOL (5 MIN) 

 SHOW: Slide 7: Get started 

 

 GOAL: Show how to open an image in Photoshop.  

https://helpx.adobe.com/photoshop/how-to/introduction-work-area.html?set=photoshop--fundamentals--photoshop-workspace
https://helpx.adobe.com/photoshop/how-to/introduction-work-area.html?set=photoshop--fundamentals--photoshop-workspace


Learn Adobe Photoshop with Surface Pro 4 and Pen – 90-Minute Workshop 

11 Microsoft confidential – for internal use only 2016 

 SAY: First, let’s open an image we can practice with. To open an image, you will always start with the 
File menu, located in the left corner of the top menu. 

 SAY: Then, select Open. You can select New to start with a blank canvas, but we are going to start 
by editing an image, so you can see how all the tools work with an existing image. Select the stock 
photo of the man or woman on your desktop. We will use the background images of Sydney and 
New York later. I will be using the image of the woman if you would like to follow along with me. 

 ACTIVITY: Lead participants through how to open an image in Photoshop: 

1. Select File by tapping in the left corner of the top menu. 
2. Select Open.  

 
3. Browse to the stock images on your Surface Pro 4.  
4. Select the image of the woman (the photo used in PPT examples). 
5. Select OK to open the image in the canvas. 

 ASK: Was everyone able to open the image? 

❗ NOTE: For additional help prior to presenting the workshop, watch the Crop and straighten video 
at https://helpx.adobe.com/photoshop/how-to/photo-editor.html. 

 SHOW: Slide 8: Brush Tool 

 

 GOAL: Review the Brush Tool using Surface Pen.  

 SAY: Let’s take a look at a feature that enables you to draw directly on an image in Photoshop. It’s 
called the Brush Tool. The Brush Tool enables you to vary the color and the thickness of your stroke, 
depending on how much pressure you apply when making a stroke.  

 SAY: You can draw anything you want with the Brush Tool, but a great use of the Brush Tool when it 
comes to fixing or correcting images is that you can use the Eyedropper Tool to match an exact 
color in the image to draw over and mask an imperfection, such as a frizzy hair or even a scar. 

 SAY: Now, let’s try the Brush Tool out! It is located midway down the left sidebar.  

https://helpx.adobe.com/photoshop/how-to/photo-editor.html
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 ACTIVITY: Lead participants through how to use the Brush Tool to draw directly on an image. 

1. Select Brush Tool.  

   
2. Select Foreground Color in the bottom left sidebar (foreground color is the top square).  
3. Use the eyedropper tool to select a color from part of the image. 
4. Brush over another area that is not the same color. 
5. Vary your pressure for the class to show how pressing harder makes a bigger stroke, and pressing 

lighter creates a more precise stroke. 

❓ ASK: Was everyone able to use the Brush Tool on the image? 
❓ ASK: How do you think you could use the Brush Tool in other ways?  

 DO: Lead participants to discuss other ways to use the Brush Tool, such as to remove the stripes in 
the shirt or possibly remove the hair from in front of the shirt. 

 SAY: Now is an important time to go over how to undo actions in Photoshop. Let’s say you don’t like 
the brush stroke you just made or it’s not exactly right. You can select Undo in the Edit menu, but if 
you want to go back a few steps, you will probably want to get in the habit of using Step 
Backward—you can undo as many actions as you have done since opening your image. Try it out! 
Undo and Step Backward are both located in the Edit menu in the left corner of the top menu. You 
will also see that there is a Step Forward option as well, for those times when you simply can’t make 
up your mind! 

 ACTIVITY: Lead participants through how to undo an action. 

1. Select Edit in the top menu next to File. 

 
2. Select Undo at the top (and point out that Undo will always specifically list the last action that 

was completed by the user). 
3. Select Step Forward to redo the action. 
4. Select Step Backward to undo the action again. 

❗ NOTE: For additional help prior to presenting the workshop, watch the How to use Photoshop 
brushes video at https://helpx.adobe.com/photoshop/how-to/photoshop-brushes-
intro.html?set=photoshop--fundamentals--paint-draw-type. 

 

https://helpx.adobe.com/photoshop/how-to/photoshop-brushes-intro.html?set=photoshop--fundamentals--paint-draw-type
https://helpx.adobe.com/photoshop/how-to/photoshop-brushes-intro.html?set=photoshop--fundamentals--paint-draw-type
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SPOT HEALING TOOL (5 MIN) 

 SHOW: Slide 9: Spot Healing Brush Tool 

 

 GOAL: Review the Spot Healing Brush Tool using Surface Pen.  

 SAY: The Brush Tool is very versatile and one of the most commonly used tools in Photoshop, but 
you may have noticed removing imperfections with it requires a lot of precision. Well, if you want to 
cover up something you don’t like, such as a wrinkle in clothes, or a crack on a sidewalk, try using the 
Spot Healing Brush Tool instead. 

 SAY: You use the Spot Healing Brush Tool in the same way as the Brush Tool, but it automates the 
blending of colors to match its surrounding area and remove the imperfection. Let’s try it out so you 
see what I mean. 

 SAY: The spot healing tool is located in left sidebar, just above the Brush Tool.  

 ACTIVITY: Lead participants through how to use the Spot Healing Brush Tool to draw directly on an 
image. 

1. Select Spot Healing Tool.  

 
2. Brush over a wrinkle in the woman’s shirt (point out to the class the dark transparent stroke that 

shows up. Indicate to them it is only temporary and a way for you to see where you just marked). 
3. Lift up your Surface Pen. The wrinkle will be less noticeable, if it hasn’t disappeared completely. 

 ASK: Was everyone able to use the Spot Healing Brush Tool on the image? 

 SAY: Keep in mind you may have to use it more than once if a blemish is particularly dark or 
noticeable.   

❓ ASK: How do you think you could use the Spot Healing Brush Tool in other ways?  

 DO: Lead participants to discuss other ways to use the Spot Healing Brush Tool, such as to remove 
the stray hairs or possibly facial blemishes or scars. 
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❗ NOTE: For additional help prior to presenting the workshop, watch: 

• Photo touch-up and spot healing tool video at https://helpx.adobe.com/photoshop/how-
to/photoshop-heal-patch-tools.html?set=photoshop--fundamentals--retouching. 

• Remove unwanted content video at https://helpx.adobe.com/photoshop/how-to/photo-
editor.html. 

 

PAINT BUCKET TOOL (5 MIN) 

 SHOW: Slide 10: Paint Bucket Tool 

 

 GOAL: Review how to use the Paint Bucket Tool.  

 SAY: So you just saw how to use the Brush Tool with a selection, but let’s take a look at how to 
dramatically change a selected area with a single tap of Surface Pen. Let’s say you want to change 
the color of the woman’s glasses quickly, simply select the Paint Bucket Tool and tap within the 
selection. Just like that, the glasses will change colors! 

 SAY: That’s not the only way you can use the Paint Bucket Tool. You can remove the selected area 
and simply click on the background. The entire background will change whatever color you have 
selected! But keep in mind, the Paint Bucket Tool will only alter blocks of color. So while the yellow 
background in this image is fairly easy to change, not all images will be so easy to change. For 
example, if there were a patchwork quilt behind this woman, I would need to tap each square of the 
quilt to change each color.  

 ACTIVITY: Lead participants through how to select different parts of an image. 

1. Select the Paint Bucket Tool. 

 
2. Tap a part of the image. (For this workshop, tap on the woman’s bright red glasses in the stock 

photo. Point out to the participants how the glasses immediately changed to the selected color.) 
3. Tap on Select in the Top menu. 
4. Tap Deselect. 

https://helpx.adobe.com/photoshop/how-to/photoshop-heal-patch-tools.html?set=photoshop--fundamentals--retouching
https://helpx.adobe.com/photoshop/how-to/photoshop-heal-patch-tools.html?set=photoshop--fundamentals--retouching
https://helpx.adobe.com/photoshop/how-to/photo-editor.html
https://helpx.adobe.com/photoshop/how-to/photo-editor.html


Learn Adobe Photoshop with Surface Pro 4 and Pen – 90-Minute Workshop 

15 Microsoft confidential – for internal use only 2016 

  
5. Point out to the participants how the dotted line is no longer active around the woman’s glasses. 
6. With no active selection, tap on the yellow background. Point out to the class how quickly you 

can change large blocks of color with the Paint Bucket Tool. 

❓ ASK: How do you think you could use the Paint Bucket Tool in other ways?  

 DO: Lead participants to discuss other ways to use the Paint Bucket Tool, such as to change the color 
of a stripe on the woman’s shirt or possibly change the color of her eye glasses. 

SAVE YOUR FIRST IMAGE (5 MIN) 

 SHOW: Slide 11: Save your image  

 

 GOAL: Review how to save an image.  

 SAY: So by now you have made a few changes to your image. It’s time to save your work. Photoshop 
will export to a lot of different file formats, but for the sake of time, I am going to show you the two 
main ways you can easily save your work. 

 SAY: First of all, Photoshop has a proprietary file format for its project files, called .PSD. The PSD file 
saves all your work that you’ve done so you can come back at any time and pick up where you left 
off. So it is always critical to first save your PSD file. 

 SAY: The PSD file is critical, but it’s not a file format that you can easily share with your friends if they 
do not also have Photoshop. So next, you are going to want to export your image to a file format 
you can send to family and friends. The fastest way to do this is appropriately named ‘Quick Export.’ 
The fastest way is using ‘Quick as a PNG.’ You may not be familiar with the PNG file format, but it’s a 
very common and very good-quality file type for images. I’ll show you how to do both a PSD and 
export to a PNG file now. Both are located in the File menu in the top left corner. 

 ACTIVITY: Lead participants through how to save a PSD file and then export it to a PNG file format. 

1. Select File. 
2. Select Save As. 
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3. Select the PSD file format and name your file. 

 
4. Go back to the File menu. 
5. Select Export.  
6. Select Export as a PNG (point out that Export As... is directly below if a participant is familiar with 

other file types and would like to select one, such as JPEG. NOTE: Do not get sidetracked 
discussing export options and file types. There are too many to discuss for a beginner-level 
workshop). 

 
7. Name your file and select OK. 

❓ ASK: Was everyone able to save a PSD file and export an image?   

 SAY: There are a number of file types you can export to in Photoshop, today we are going to talk 
about two. For example, you may have heard of JPEG’s a lot, which is a very common type of digital 
image. However, a PNG is very useful, because it is a file type that can preserve transparent layers in 
an image. Don’t worry, we will cover transparencies in images more in just a moment. 

❗ NOTE: For additional help prior to presenting the workshop, watch the Sharpen and save video at 
https://helpx.adobe.com/photoshop/how-to/photo-editor.html. 

 

Section Three: Enhance Your Images (30 minutes) 

FILTERS (5 MIN) 

https://helpx.adobe.com/photoshop/how-to/photo-editor.html
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 SHOW: Slide 12: Filters 

 

 GOAL: Show how to use filters to alter an image.  

 SAY: At this point we have made some subtle changes to an image, but there’s a lot more you can 
do in Photoshop than simply remove some blemishes or draw on a photo. Now we are going to go 
over how you can adjust the overall look of your entire image with some more sophisticated tools.  

 SAY: First, let’s take a look at Filters. If you have ever adjusted the brightness of color of a picture on 
your phone, you will have an idea of what this feature can do. Of course, in Photoshop, the filters are 
much more sophisticated. Let’s take a look at the ‘Oil Paint’ Filter. 

 ACTIVITY: Show how to use a filter to make an image look like an oil painting. 

1. Select Filters. 
2. Select Stylize. 
3. Select Oil Paint and check the Preview box in the Oil Paint pop-up menu. 

     
4. Adjust the options (and demonstrate how much the image changes when you change the 

Lighting slide). 

❓ ASK: Was everyone able to adjust their image with the Oil Paint filter?   
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 SAY: If you were able to get the hang of the filters quickly, try another one out from the Filters drop-
down menu. There are a lot of different ways you can change and enhance your photos using filters! 
Take a moment and apply some other Filters to your image. 

❗ NOTE: For additional help prior to presenting the workshop, watch: 

• Use Photoshop filters for photo edits and effects video at 
https://helpx.adobe.com/photoshop/how-to/filter-effects.html?set=photoshop--fundamentals--
filters. 

• Add creative effects video at https://helpx.adobe.com/photoshop/how-to/photo-editor.html. 

CREATE A LAYER (8 MIN) 

 SHOW: Slide 13: Create a Layer 

 

 GOAL: Review the layers feature in Photoshop.  

 SAY: Now we have made it to one of the features that really sets Photoshop apart from other image 
editing software—layers! You can actually create multiple layers in a single image. That’s why saving 
your PSD file is so important. Within a single image you are editing, you can literally have countless 
layers, and as you will all learn in a few moments, that means you can work with multiple images 
within a single file. First, let’s learn how to create a new layer. 

 ACTIVITY: Lead participants through how to add a new layer: 

1. Select Layers in the Top menu. 
2. Select New, then Layer. 

 
3. When prompted, name the new layer ‘Brush.’ 
4. Make sure the ‘Brush’ layer is selected and then draw on the image with the Brush Tool. 
5. Point out how you have drawn on the image, and then tap on the eye icon to the immediate left 

of the ‘Brush’ layer (Layer window in bottom right corner of Photoshop). 

https://helpx.adobe.com/photoshop/how-to/filter-effects.html?set=photoshop--fundamentals--filters
https://helpx.adobe.com/photoshop/how-to/filter-effects.html?set=photoshop--fundamentals--filters
https://helpx.adobe.com/photoshop/how-to/photo-editor.html
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6. Explain to the participants that by hiding the layer you can then export the image without the 
brush stroke on it. However, you can simply click on the eye icon to have the brush stroke come 
back. 

 SAY: Please be sure you have mastered how to create a layer before we continue. The next few 
activities rely heavily on you being able to use Layers. 

❗ NOTE: For additional help prior to presenting the workshop, watch: 

• Introduction to layers video at https://helpx.adobe.com/photoshop/how-to/layer-basics-
explained.html?set=photoshop--fundamentals--layers. 

• Improve lighting and color video at https://helpx.adobe.com/photoshop/how-to/photo-
editor.html. 

  

LAYER STYLES (5 MIN) 

 SHOW: Slide 14: Layer Styles 

 

 GOAL: Review layer styles in Photoshop.  

 SAY: You have seen how to create a new layer and make some edits to it, but similar to filters, there 
are layer styles, where you can adjust only the individual layer you select. Let’s explore some of the 
different styles. 

 ACTIVITY: Lead participants through how to use layer styles: 

1. Double tap the Background layer. 
2. Rename Layer 0 when prompted. 
3. Double tap Layer 0. 
4. The Layer Styles dialog box will open.  

https://helpx.adobe.com/photoshop/how-to/layer-basics-explained.html?set=photoshop--fundamentals--layers
https://helpx.adobe.com/photoshop/how-to/layer-basics-explained.html?set=photoshop--fundamentals--layers
https://helpx.adobe.com/photoshop/how-to/photo-editor.html
https://helpx.adobe.com/photoshop/how-to/photo-editor.html
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5. Select Bevel & Emboss. 
6. Select Texture (this style will be very noticeable for the image of the woman).  
7. Adjust the Depth slider. (Remind participants that they should verify that Bevel & Emboss is 

highlighted. Each Layer Style has its own window of options, but it only appears when that Layer 
Style is actively selected). 

8. Point out that only that layer will be affected.  

 SAY: Take some time to experiment with some of the other Layer Styles you see there, such as Drop 
Shadow and Color Overlay. 

❓ ASK: What other Layer Styles did you find useful?  

 DO: Lead participants to discuss other Layer Styles, such as adding a drop shadow to certain layers, 
or using Color Overlay to re-color parts of an image.   

ERASER TOOL (8 MIN) 

 SHOW: Slide 15: Eraser Tool 

 

 GOAL: Review the Eraser Tool using Surface Pen.  

 SAY: So we have used the Brush Tool and the Spot Healing Tool to adjust an image, but let’s say you 
want to get rid of a part of your image entirely. You can always use the traditional Eraser Tool, but 
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keep in mind it eliminates the part of the image you touch entirely and shows only a stark color in its 
place (the default color is white). Like the Brush Tool though, you can vary the sensitivity in case you 
want to make a very precise removal in your image. 

 SAY: Plus, a great feature of Surface Pen is that you can simply click on the side button and hold 
down to erase. So to erase part of your image in Photoshop, you actually have two options when you 
use Surface Pro 4 with Surface Pen. Let’s give both ways a try so you can see which method you 
prefer. First let’s use the Erase Tool in Photoshop, located in the left sidebar a little bit below the 
brush tool. 

 ACTIVITY: Lead participants through how to erase parts of an image using the Eraser Tool and the 
erase feature of Surface Pen. 

1. Select the Eraser Tool.  

 
2. Brush over an area in the image (try to remove the woman’s coffee cup if you can). 
3. Demonstrate that you can vary the size of the brush stroke by adding pressure with Surface Pen. 
4. Select File and then Place Embedded. 
5. Browse to the image of the woman again and tap Place in the bottom-right corner of the 

window. 
6. A new layer is automatically created. 
7. Move the new image layer beneath Layer 0. The empty cup label will be filled with the image of 

the woman below. Move the image around to place the woman’s face in the coffee cup (see 
example image on Slide 15). 

 SAY: Once you have gotten the hang of the Eraser Tool, try clicking on the right button of Surface 
Pen to erase part of your image. 

❓ ASK: Which method did everyone prefer? 
❓ ASK: How do you think you could use the Eraser in other ways?  

 DO: Lead participants to discuss other ways to use the Eraser Tool, such as to remove people from 
the background, i.e. a “photobomber.”   
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MAGIC WAND TOOL (5 MIN) 

 SHOW: Slide 16: Magic Wand Tool 

 

 GOAL: Review the Magic Wand and select tool options.  

 SAY: Adjusting the precision of the brush and erase tools are not the only way to focus in on a 
certain part of your image. You can also use the Magic Wand or other selection tools from the left 
sidebar. 

 ACTIVITY: Lead participants through how to select different parts of an image. 

1. Select the Magic Wand Tool.  

 
2. Tap a part of the image. (For this workshop, tap on the woman’s bright red glasses in the stock 

photo. Point out to the participants the dotted line that appears around the glasses.) 
3. Select the Brush Tool. 
4. Brush over the glasses. Point out that because the glasses are selected and highlighted, you do 

not have to worry about not being exact. Your brush strokes will not register on Surface Pro 4 
outside the selection. 

 SAY: Remember that you can extend the area you have selected by holding the Shift key and 
tapping a nearby area. This can be handy for something like selecting an entire background or 
selecting an entire person or multiple people. 

❗ NOTE: For additional help prior to presenting the workshop, watch the Selecting part of an image 
video at https://helpx.adobe.com/photoshop/how-to/select-part-photo.html?set=photoshop--
fundamentals--select-image-part. 

Section Four: Combine Multiple Photos (25 minutes) 

LAYER MASKS (15 MIN) 

 SHOW: Slide 17: Layer Masks 

https://helpx.adobe.com/photoshop/how-to/select-part-photo.html?set=photoshop--fundamentals--select-image-part
https://helpx.adobe.com/photoshop/how-to/select-part-photo.html?set=photoshop--fundamentals--select-image-part
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 GOAL: Allow participants to create a second image with a layer mask.  

 SAY: Now that you know how to create a layer and add a style, let’s take it to the next level and 
bring an image in as a layer. With other image editors, you can only edit a given photo, but with 
Photoshop you can combine multiple photos into one!  

 SAY: Using the Place Embedded… option in the File menu enables you to overlap images on top of 
each other. However, if you apply what is called a layer mask, you can combine specific elements you 
like from one image with another. For example, let’s say you like a picture of yourself, but you don’t 
like the background. Well, with a layer mask, you can select a person, delete the background and 
insert them into whatever background or photo you like! Let’s give it a shot! 

 ACTIVITY: Help participants create a layer mask with a transparent background.  

1. Use Magic Wand Tool to select the background (remind participants to verify Layer 0 is selected, 
and to use the Shift key to select all parts of the background). 

2. Go to Select in the top menu. 
3. Tap Inverse (the woman should now be selected instead of the background). 
4. Select the Mask icon along the bottom of the Layer window (the background should 

automatically disappear and a Layer Mask icon should appear in Layer 0). 

 
5. The background should disappear. 
6. Save as PSD titled WomanLayerMask. 
7. Open the stock photo of the Sydney Opera House (File and then Open. Point out to participants 

that they will then have two images open in Photoshop at the same time, which is okay). 
8. In the Sydney Opera House image, select File and then Place Embedded. 
9. Select the WomanLayerMask PSD file and tap Place. 
10. The woman should automatically appear in front of the Sydney Opera House as though she is in 

the foreground of the photo (see example on Slide 18). Adjust the size of the woman to place her 
in front of the background. 

❗ NOTE: For additional help prior to presenting the workshop, watch the Mask out part of an image 
video at https://helpx.adobe.com/photoshop/using/masking-layers.html. 

  

https://helpx.adobe.com/photoshop/using/masking-layers.html
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 SHOW: Slide 18: How did you do? 

 

 GOAL: Encourage participants to share their photos.  

 SAY: Please share your images with other participants.  

 ASK: How did you do? Is your image the same as the one on screen? Does your image look like 
everyone else’s? 

 DO: Encourage participants to share their images with each other. 

CREATE YOUR OWN IMAGE (10 MIN) 

 SHOW: Slide 19: What will you create next? 

 

 GOAL: Review what participants have learned and get them excited about Photoshop.  

 SAY: Now I want everyone to use what you have learned today and create your own image. To make 
it a little more fun for you, we pre-loaded your Surface Pro 4 with some high quality stock images. 

 SAY: Think back to the activities we just did, and now think about how to use those tools in a 
creative way. You can create an original drawing by opening a New canvas, or draw on an existing 
image you open up. You can use a layer mask and put a background from anywhere in the world 
behind you to trick your friends. Or you can create a collage of a bunch of different images or parts 
of images on a single canvas. The choice is up to you now! 

 ACTIVITY: Allow participants to create their own image.  

 DO: Walk around the class and assist participants with questions on Photoshop and how to use the 
different tools.  

Section Five: Wrap Up (5 minutes) 
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WRAP UP AND THANK YOU (5 MIN) 

 SHOW: Slide 20: Join us 

 

 GOAL: Encourage participants to attend future Microsoft retail store sessions.  

❗ NOTE: This prompt may be personalized by CDS to meet local requirements. 

 SAY: If you would like to learn more about upcoming events, we have our store schedule available 
and I’d encourage you to pick up a copy to take home with you. We also have online resources for 
you to bookmark as shown here on the slide. 

 SHOW: Slide 21: Schedule of events (placeholder 1 of 2) 

 

 GOAL: Please replace this slide with the current Schedule of Events to promote your store’s 
upcoming events.  

 SAY: Let’s quickly review some upcoming events scheduled in our store that may be of interest and 
you might like to make sure you have a spot registered…. 

 SHOW: Slide 22: Additional marketing (placeholder 2 of 2) 

 

 GOAL: Please replace this slide with slides from your latest Marketing Kit to promote upcoming 
sessions or events. Choose ones that are most appropriate for this audience.  
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 DO: Personalize this prompt to align with selected marketing material. 

 SHOW: Slide 23: Thank you 

 

 GOAL: Thank participants and encourage them to attend another workshop or event.  

 SAY: Thank you for coming to today’s workshop. You now know that you can use Adobe Photoshop 
CC with Surface Pro and Surface Pen to create your own images! You will be receiving a feedback 
form via email. Please remember to complete it and send it back because we are always looking for 
ways to improve our workshops and make them even more valuable to you. 

 SAY: If you have any questions, please feel free to stick around to talk to me. I hope to see you at 
one of our upcoming workshops! 

 DO: Answer any questions from participants.   
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